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Displaying Chartstrings: The UMB Project By Department Report

	1.  
	Begin by navigating to the UMB Project By Department Report on the General Ledger menu in eUMB Financials.

Click the General Ledger link.
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	2.  
	For easier viewing, you may want to maximize your Internet Explorer window. 

Continue navigating to the UMB Project By Department Report. 

Click the General Reports link.
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	3.  
	Click the UMB Project by Deptartment Rpt link.
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	4.  
	A Run Control ID is required to run a report in eUMB Financials. The system uses Run Control IDs to track your report request through all stages of its creation. The following statements are true in eUMB Financials:

     - Run Control IDs can be used to run any report within eUMB Financials. 

     - They can be re-used. You do not need to create a new Run Control ID each time you run a report.

     - A Run Control ID manages one report request at a time. 

 

     - To run more than one report at the same time time, create more than one Run Control ID.

     - Run Control IDs cannot be deleted.

	5.  
	If you haven't set up any Run Control IDs in eUMB Financials, you will need to Add a New Value. 

(Otherwise, you can click the Search button on Find an Existing Value tab, then select from the list that's returned.)

Click the Add a New Value tab.
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	6.  
	Run Control ID names can contain uppercase, lowercase or mixed characters. They cannot contain spaces. Insert an underscore if you wish to separate words.

Name your Run Control ID.

Enter the desired information into the Run Control ID field. Enter a valid value e.g. "project_by_dept".

	7.  
	Click the Add button.
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	8.  
	The UMB Project By Department Report can retrieve by...

     - a single Owner Department ID (enter ID in Department field)

     - a group of related departments (enter highest level ID in Department field) 

This report will not retrieve data without a Department ID in the Department field.

In this example we will run the report for a group of related departments by entering a high level Department ID. You could also use the Lookup button to search for the Department ID. The Lookup button is located to the right of the Project field. 

Enter the desired information into the Department field. Enter a valid value e.g. "10417000".

	9.  
	Click the Run button.
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	10.  
	Review the Process List on the Process Scheduler Request page:

     - a check should appear in the Select checkbox

     - the name of the report should appear under Description
     - Type and Format should remain 'Web' and 'PDF'

     - all other settings should remain unchanged 

Click the OK button.
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	11.  
	Note that a Process Instance number (boxed in blue) now appears beneath the Run button. This is your indication that you have successfully submitted your report. 

Make note of the Process Instance number. You will use the Process Instance number later to locate the report you wish to view. 

	12.  
	Both Report Manager and Process Monitor pages provide the ability to... 

     - monitor report progress/status

     - view report results

     - email report results

     - print report results

     - save a copy of report results

In this example, we will use Process Monitor. You could also follow similar steps to use Report Manager. 

	13.  
	Click the Process Monitor link.
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	14.  
	You may wish to collapse the menu to give yourself more viewing space.

Click the Collapse (Ctrl+Y) button.
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	15.  
	Your User ID (your Employee or Affiliate ID) should appear in the User ID field.

Reports run previously are available online for up to 98 days after the run date. 

For direct access to reports run at another time, use the following menu path: PeopleTools > Process Scheduler > Process Monitor.

	16.  
	The UMB Project By Department Report usually takes a few minutes to run to success. 

It is possible to check the status of your report by clicking the Refresh button periodically and viewing the Run Status and Distribution Status columns. 

This report has not finished running yet. Completed reports will show Run Status = Success and Distribution Status = Posted. Refresh the page for a status update.

Click the Refresh button.
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	17.  
	The report has finished running. When Run Status = Success and Distribution Status = Posted, you will be able to view the report. View details on the report.

NOTE: If you have submitted multiple reports, use the Process Instance number (boxed in green) to identify the report you wish to view.

Click the Details link.
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	18.  
	Click the View Log/Trace link.
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	19.  
	The UMB Project By Department Report provides both viewing and downloading options (boxed in blue). We will view results first, then download and import results into Excel.

Click the .PDF link.
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	20.  
	Report results are displayed in a new window. Maximize the window for easiest viewing.

Results represent all of the requested department's projects as recorded in eUMB Financials. 

	21.  
	To increase or decrease display size, use the zoom percent (boxed in green above).

Action buttons for the following additional options are boxed in blue above:

      - Save a Copy

      - Print

      - Email

      - Search 

The Help menu located at the top of the page provides specific directions for using each of these features.

	22.  
	Report results for UMB Project By Department Report can also be downloaded and imported into Microsoft Excel. The next series of frames will detail the steps to download and import results into Excel.

NOTE: You can download results successfully without viewing the .PDF version of the report first. However, to save time you may wish to review results before going through the steps required to download to Excel.

Close the .PDF version of the report.

Click the Close button.
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	23.  
	The .txt link is used for downloading data to be imported into Excel.

Right-click the dept_project.txt link.
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	24.  
	Click the SaveTarget As... menu.
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	25.  
	The File Download and Save As dialog boxes open. 

Name the file using the File name field.

Enter the desired information into the field. Enter a valid value e.g. "dept_project_110706".

	26.  
	Click the Save button.
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	27.  
	Next we will import the report results into Excel. Close the Download complete dialog box.

Click the Close button.
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	28.  
	Minimize the eUMB Financials window. 

Click the Minimize button.
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	29.  
	Launch Microsoft Excel.

Click the start button.



	30.  
	Click the Microsoft Office Excel 2003 menu.
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	31.  
	Open the downloaded text (.txt) file containing the report results.

Click the File menu.
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	32.  
	Click the Open... menu.

	33.  
	Search for the text file containing downloaded results.

Click the button to the right of the Files of type field.
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	34.  
	Expand the search to all file types, including text (.txt) files.

Click the All Files list item.
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	35.  
	Open the text file we saved earlier: dept_project_110706.txt. 

In this example, we will double click on the file name to open the file. (Single clicking the file name, then clicking the Open button will also work in Excel.)

Double-click the desired entry in the list.
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	36.  
	The Text Import Wizard opens. For this report, we need only 2 of the 3 steps in the wizard to make selections that will accurately import the text file into Microsoft Excel. (Other reports may require all 3 steps.)

In Text Import Wizard - Step 1, confirm the following default selections:

     - Delimited is the file type selected (boxed in blue)

     - The saved location of the text file you are importing appears next to "Preview of file..." (boxed in blue)

Click the Next button.
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	37.  
	In Text Import Wizard - Step 2, you will...

     - change the Delimiter from Tab to Other
     - specify the Other delimiter symbol

     - finish the import

Begin by unchecking the Tab checkbox. 

 

Click the Tab checkbox option.
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	38.  
	Click the Other checkbox option.
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	39.  
	Enter the Other delimiter. Use the "pipe" delimiter, a symbol that looks like a vertical line: |. On PC keyboards it is usually located on a key just above the right Enter key.

  

Enter the desired information into the Other field. Enter a valid value e.g. "|".

	40.  
	Notice that the text displayed in Data preview is now lined up in columns that are separated by a continuous vertical line.

Click the Finish button.
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	41.  
	You have successfully imported the report results into an Excel worksheet!

Name and save the Excel worksheet.

Click the File menu.
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	42.  
	Click the Save As... menu.
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	43.  
	Save the file as an Excel worksheet.

Display the Save as type options.

Click the button to the right of the Save as type field.
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	44.  
	You may need to scroll to the top of the dropdown list to see the Microsoft Excel option.

Click the Microsoft Excel Workbook list item.
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	45.  
	Save the new Excel worksheet containing report results.

Click the Save button.
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	46.  
	You have successfully imported your text file into Microsoft Excel and saved your new worksheet. 

We will finish with two formatting steps that will make it easier to work with your data in this Excel worksheet:

     - Format all column headers (titles) if you will need to use the AutoFilter, Data Sort or PivotTable features on Excel's Data menu.

     - Adjust all column widths to display all characters 

	47.  
	Select the row containing the column headers (titles) - Row 1. 

Click the Row 1 cell.
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	48.  
	Bold the column headers (titles). Applying a format to the header titles (Row 1) will make it possible to use AutoFilter, Data Sort or PivotTable features with this data. 

Click the Bold button.

[image: image35.png]




	49.  
	All column headers (titles) are now bold.

Next, re-format column widths so that all characters are visible. 

Select the entire worksheet by clicking the blank cell directly above the Row border titled '1'.

Click the blank cell.
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	50.  
	With the worksheet selected, place your mouse pointer on top of the vertical line between columns A and B. 

When you are in the right spot, your mouse pointer will display a double- pointed arrow pointing left and right. Hold the mouse steady.

Double-click the cell margin cell.
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	51.  
	De-select the worksheet by clicking anywhwere in the data area (not on the bolded headers).

Save the formatted worksheet.

Click the Save button.

	52.  
	You have successfully run, viewed and downloaded results from the UMB Project By Department Report.

Questions on report results should be directed to:

     - Restricted Funds for Grants and Contracts
     - Financial Services Quality Assurance for all other sources of funds 

End of Procedure.


	Page 6
	Date Created: 1/22/2007


Page 7
	Date Created: 1/22/2007
	



[image: image38.png][image: image39.png]